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Chapter 1

About

Meganizer helps you to organize your media collections. But the organization
is only understanded as a base to offer many usefull features. The management
of wishes, ideas for presents are only examples. You can also manage literature
lists for projects (like Master thesis, books, articles, ...).
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Chapter 2

Installation and
Configuration

To get Meganizer, their are two ways. The preferred way is to use a provided
package (s. 2.1) for your platform (e.g. Windows, Ubuntu, OpenSUSE, ...).
The second way is to compile it for your own. But be aware, that you need an
AWS Account to use Amazon if your are building Meganizer from source.

2.1 Install Meganizer-Packages

2.1.1 Linux

To install Meganizer, you must add the repository to your sources (s. next
paragraph or tab. 2.1). To do so, go to http://ftp.engsas.de/stable and choose
*.list file (deb based) or *.repo file (rpm based) for your distribution. Afterwards
you can install Meganizer with help of your favorit package management system
(like aptitude or yum). If you already have an database installed, you can go
to 2.2.1. Ohterwise go on with 2.3.
PackageKit is used by some distributions (like Ubuntu) to install software. To
add a repostiry, start PackageKit from the program menu of your desktop system
(like KDE-Menu -¿ System -¿ Add / Remove Software). In PackageKit, choose
Settings and Edit Software Sources (s. Fig. 2.1). There open the Other Software
tab and click on Add (s. Fig. 2.1). In the upcoming dialog, type in the url to
our repository. It starts with deb for Debian repositories followed by the url.
The next part is the version number of your distribution (Ubuntu Lucid is 10.04
and Maverick is 10.10). The last part is the repository type, which is contrib in
our case.

Table 2.1: Hilfen zur Quelleneinrichtung
Distribution Link
Ubuntu’s http://wiki.ubuntuusers.de/Paketquellen freischalten

Fedora
http://docs.fedoraproject.org/en-US/Fedora/12/html/
Deployment Guide/sec-Configuring Yum and Yum Repositories.html
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Figure 2.1: Quellenverwaltung in KPackageKit

Figure 2.2: Quelle hinzufügen in KPackageKit
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Figure 2.3: MySQL-Server herunterladen und installieren lassen

2.1.2 Mac

Mac platform is not supported with packages right now. But Meganizer should
run on Mac OS. So you must compile it from source (s. 2.1.4).

2.1.3 Windows

Download the windows installer from http://ftp.engsas.de/stable/win/Meganizer-
0.3.2-win32.exe, execute it and follow the instructions.
If you do not want to setup an MySQL-Server on that machine, do not acti-
vate Download and install MySQL-Server and read on at 2.3 after closing the
installer. Otherwise choose Download and install MySQL-Server like Fig. 2.3
shows. After clicking on Next, the download will start. This may take a while,
since about 40MB must be downloaded. If the download has finished, the setup
starts automatically. Please follow it’s instructions than. At the last page make
sure Configure Now is activated like shown in Fig. 2.4. At the upcoming di-
alog choose the standard configuration (s. Fig. 2.5). This makes sure, that
the MySQL-Server is started as a daemon in background everytime you start
windows. It is also important to remind the password of the root user.
If you’ve finished that part, please finish the setup of Meganizer. At the last
page, you can choose, wether Meganizer should be started afterwards automat-
ically. To open the online documentation, choose Show Readme also. The next
step is the configuration of Meganizer, which is described at 2.3. There you can
also choose to create a new database and a user.
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Figure 2.4: Choose Configure Now at the last page of installation

Figure 2.5: Choosing the standard configuration

6



2.1.4 Building from Sources

Linux

Download source package from http://ftp.engsas.de/stable/src und unpack it.
Afterwards you can look at the depencencies.xml in the subdirectories of src
to know which software is needed to build Meganizer. If you have installed all
dependencies and switched to the unpacked sources, you can build and install
Meganizer with

cmake -DBUILD PACKAGE=ON -DWITH ALL PLUGINS=ON \
-DL10N ALL=ON ./
make install

Mac

Windows

Insall

• Qt 4 with MinGW from http://qt.nokia.com/downloads

• CMake from http://www.cmake.org/cmake/resources/software.html

• OpenSSL from http://www.slproweb.com/products/Win32OpenSSL.html

• QCA2-src Package for MinGW from https://sourceforge.net/projects/kde-
windows/files/qca

Edit qca\cmake\modules\FindOpenSSL.cmake and comment out the line

MARK AS ADVANCED(OPENSSL INCLUDE DIR OPENSSL LIBRARIES)

so that it looks like
#MARK AS ADVANCED(OPENSSL INCLUDE DIR OPENSSL LIBRARIES)

now.
Further on, make sure that the MinGW\bin directory within your Qt instal-
lation and Qt itself is listed in your path variable. To do so, click right on
Workspace and choose Properties. Afterwards you can edit the environment
variables at the tab Advanced (s. Fig. 2.6).
Configure QCA with CMake and make sure, that you configured QCA with
CMAKE BUILD TYPE set to Release, if you want to build Meganizer with
BUILD DEBUG=Off (like recommended). After that you can build and install
QCA with mingw32-make install. After installing, jump into the installed qca
directory (Standard: c:\Programme\QCA\bin) and execute

qcatool2.exe plugins

and you should see the following lines:
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Figure 2.6: Setup the environmental variables in Windows XP

Available Providers:
qca-ossl
This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)

The next step is to build the mysql plugin for Qt.
The last step is to configure Meganizer with CMake and build it with mingw32-
make install.

2.2 Install and configure the database

2.2.1 Linux

This part is only needed, if you do not have already setup a database. If you
already have a database to use with Meganizer, but you do not have Meganizer
configured to use this database, you can skip this paragraph.
Meganizer uses MySQL as database system. Therefore you must be sure, that
MySQL-Server is running on your choosen System. Since the MySQL-Server is
in nearly every distribution, this task is mostly done by the package manage-
ment. Please follow 2.3 afterwards. There you can create a database and a new
user too.
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Figure 2.7: Database settings at the setupwizard

2.2.2 Mac

You need to install the MySQL-Server first. Please follow 2.3 afterwards. There
you can create a database and a new user too.

2.3 Configure Meganizer

Meganizer uses a setupwizard to guide you through the first configure process
and updates later on. The most important step is the configuration of the
database connection (s. fig. 2.7). If Create Database is activated, Meganizer ask
you to login with administrator privileges and creates the database afterwards.
To create a user, set it’s password and grant the needed privileges, choose Create
User. Afterwards the wizard creates the needed database structure or updates
an exsting older structure.
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Chapter 3

Basics and philsophies

3.1 Basic usage

The start of every operation with a medium is the search after that medium.
This process is choosen, to prevent you from inserting the same medium several
times, because normaly you should have found the already inserted one, before
you be able to insert it again. The second advantage of this process is the
integration of external sources (like Amazon), which you can use to insert new
media.
To actually do the search, the search widget is used (s. fig. 3.1). This widget is
at the left side after first start. This window is a dock widget like many other
widgets from Meganizer. Therefore you can move, close, resize this widgets
as you like. If you have closed a widget which you want to use later on, you
can show it again with a click on the corresponding entry at the View menu.
Meganizer saves the widget layout and sizes at all exits and restores the layout
at the next start. This way you have your prefered layout, but closed widgets
does not appear automatically again after a restart.
If you have problems to associate the icons with correct actions at the beginning,
you can turn the corresponding text at the settings dialog. Afterwards the text
is shown below the icons. The settings dialog can be reached via the Settings
entry at Edit menu.

3.2 Medium Identification Number

The MIN is used to identify an medium (s. Tab. 3.1). But many types of
media have different types of numbers. Even the same media type can have
different numbers in different regions, also some media have more than one type
of numbers.
If you change the MIN of a medium, the system tries to detect the type of the
number and set it accordingly. But it can be, that the type you want to use,
is not supported by default. So you can add a new type and you must than
manualy select this type. If the system knows, which type you entered, it also
tries to validate your entered number.
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Figure 3.1: Application user interface after the start

Table 3.1: Overview over different MIN’s
Type Description Media Convertible

EAN European Article Number Any ISBN-13, UPC
ISBN-13 International Standard

Book Number
Books ISBN-10

ISBN-10 International Standard
Book Number

Books

UPC Universal Product Code CD’s, Movies, DVD
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Chapter 4

Usage

4.1 Search for Media

The search after media is done via the search widget, which is placed at the left
side. You should start the process with choosing the appropriate media type.
This is useful, if you want to work with the selected media type later on. The
choose of a media type allows you to add, view and edit media type special fields
(like tracks for music devices). A search with all media types, allows you only to
view and edit properties, which are shared by all types (like title). The results of
your search are displayed at the main window. The firlst column at the result
table shows you, where the medium is found. The Meganizer logo indicates,
that the data are out of the local datbase, where any other symbol indicates the
specific searchplugin, which provides the data (e.g. for Amazon). With help
of the option Area the include of external sources can be allowed, disallowd and
forced. The standard options means, that the local database is searh for your
own media first. If there are no results, the local database is searched for media
of other people. And finally external sources are queried, if nothing was found
before.

4.1.1 Using external Datasources (like Amazon)

Searchplugins are used to search external datasources, if the medium wasn’t
found in local database. Actually only Amazon can be searched. Generally
two steps need to be done. First any datasource has different media types with
different names. Therefore a connection between known types of Meganizer and
the types of the datasource must be done (s. Fig. 4.1). This dialog appears
automatically on the first search if no connections are made. You may change
the connection later on at the Settingsdialog of the specific source.
As second task, the special properties of the mediatype in Meganizer must be
connected with the special properties of the datasource type. This is needed,
because the plugins doesn’t know anything about special types. They only
know the standard properties which have all types in common (like Genre,
Title, Manufacturer). The connection dialog of properties appears also on first
search and can be reached at the same place in the Settingsdialog. At the dialog
(s. Fig. 4.2), you choose a property of Meganizer and the corresponding one
at the datasource. Afterwards you press on Connect to connect them. If you
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Figure 4.1: Connection between media types of Meganizer and searchprovider

want to release a connection, click on it and click the button with red minus as
symbol.

4.1.2 Export List of Media

If you want to export a list of media, you must first compose a search, where
all media are into. Afterwards, you can select the media you want like in every
other application. If you want to select all, press Ctrl+A or does not choose any
entry. In both cases all media in list would be exported. Finally click on Export
at the context menu or at the toolbar to start the export. You can choose the
location and the format of the export. Right now HTMl- and OpenDocument-
Format are provided.

4.2 Add new Media

The adding of new media starts with a search after the media you want to add
(s. 3.1). To do this, you should start with choosing the wanted media type.
Afterwards the results are shown as before. To add one medium, select it with
a left click and choose Add Selected from the context menu or from the toolbar.
This opens the details dialog where you can adjust the properties. You should
set all important properties carefully to make sure, that you find the media again
later on. With a click on Ok the medium will be added and the Meganizer icon
appears at the first column. If no result is found, you can click on New at the
context menu or the toolbar.

4.3 Edit Media

The editing of media can be done at the known detail window. You can reach
it at the context menu or the toolbar after selecting the medium.
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Figure 4.2: Connection of media attributes

4.4 Handling of virtual Media

Virtual media are understood in Meganizer as media, which are stored at the
database, but not physical present. For example your wishes are virtual media,
because you know the medium, but you don’t have it at your bookshelf. Also
present ideas for others or literature can be virtual media.

4.4.1 Wishes

In Meganizer wishes are meant as media, which a owner wants to have. For
example, if you want to present someone with a new book, the book is a gift
idea and not your wish. So wishs are owned by the one who have the wish and
may have the medium some time later on.
You can mark a medium as wish by activating the checkbox after Wish at the
Owner Details tab at the details window of the medium. If you want to see all
your wishes (or the wishes of something else), start a search and select Wishs
as Status. To export this list, follow the instructions at 4.1.2.

4.4.2 Gift ideas

You can also store your gift ideas into Meganizer. To do so, make sure, that
the person you want to give the present is already into the database. Therefore
click on User at File menu to open the user dialog. If the user is not listed,
create a new user. But be aware to left the user name free, if the user does not
use the database. Otherwise you won’t be able to handle the loaned media from
this person at Meganizer.
If the user is present, add the medium to the database. Afterwards go to the
detail window of it and choose Other (s. Fig. 4.3). On the right side you can
select the user you want to make a present and add it to the presnetees by
clicking on the arrow pointing to the left. Don’t you own the medium yourself,
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activate gift only to make it a virtual medium. To remove someone, select him
and click on the button with the arrow pointing to the right.
After giving the gift to the recipient, you can mark the medium as Already
given. The advantage is, that Meganizer adds the recipient to the owners of
the medium automatically. Further on, it removes you from the owner list, if
you mark the medium as Gift only. Afterwards the recipient is not available
as a recipient for this medium anymore. To mark an gift as given, click on the
presentee at the tab Other from the detailswidget with the right mouse button
and choose Already given from the context menu.
To view all your gift ideas, select Wishes and Gifts as Status and run the search.
To export the list, follow the instructions at 4.1.2. By the way the gift ideas are
not visible for the presentee.

4.4.3 Literature

Under literature we understand a medium, which is used at a project. A project
can be something like a master thesis or an article or anything else, which you
use other media for. To create a new project or change existing ones, click on
Projects in File menu. This dialog behaves like the dialogs described in ??. If
you want to find a specific project, type in some part of the name into the filter
field. In the list below you can see the results immediatly (s. Fig. 4.4).
To create a new project, click on New on the bottom right or to edit an existing
one, select it and click on Edit. Afterwards the right side of the window is
enabled and you can type in at least the name of the project. The resulting
media, can be a media from the local database. It can be set, if the project
result in a new medium. After storing the new project, you can add and remove
materials at the Materials tab. To add one click on the green plus and to remove
one, select it and click on the red minus. You may enter a comment for each
material (s. Fig. 4.5).
If you doesn’t own the materials you are using at your projects, you can mark
them as virtual media by activating the checkbox after Literature at the Owner
Details tab of the details window.

4.5 Buying Media

You can buy media directly out of Meganizer. Right now you can use Amazon
as a dealer. Out of Meganizer you can buy any media, which can be found at
the local or any external sources. If you found the medium you want to buy,
select it and choose Buy from the context menu or the toolbar. After that your
shopping cart appears on the right side as shown in fig. 4.6. Their you can
see, what media you selected to and how much for which price. Also the small
icon on the bottom right of each medium shows you, which seller is selected.
Further on, the color of the medium is used to show the state. Red means, that
no offer is found. Orange shows, that offers are found, but not as much items
as you want. If everything is ok, the box appears in green. If the background is
dotted, you can see, that it is an second hand offer. Which offers are allowed,
can be setup at the settingsdialog of each searchprovider. Per default only new
products von original sellers are choosen (e.g.: At Amazon per default, market
place sellers are ignored).
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Figure 4.3: Marking medium as a gift idea
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Figure 4.4: Die Projektverwaltung in Meganizer

Figure 4.5: Für das Projekt verwendete Medien
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Figure 4.6: The Shoppingcart
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To increase the amount of an item, select it and klick on + or use the context
menu. To decrease it, you can also use the context menu or press -. With
Del -Key you can remove it. At the context menu, you can also choose the shop
and the used offer off the choosen shop. In auto Mode Meganizer tries to buy
the items as cheap as possible. But also tries to take the shipping costs into
account.
If you configured your shopping cart as you want, you can proceed with a click
on Buy. Then Meganizer creates all needed shopping carts at the sellers and
redirect you one after the other to the filled shopping cart of the seller. After
that, all media will be added to the database, if their not in already.

4.6 Loaning Media

Meganizer allows to manage the loan process of media, which you borrowed to
someone and which you borrowed from someone. Loaning is done by a special
dialog. You can reach it within the detail window of a medium at the tab
Loaning (s. Fig. 4.7) or at the context menu or toolbar. Their you can walk
through the whole loaning process. The summary of your loaned media to and
from others is shown at the startpage of Meganizer, which you can reach via
the View menu with a click on Summary.

4.7 Edit data around Media

Data for media can be data like persons or genres, which are shared among
different media (also known as foreignkeys). To edit them, Meganizer provides
special dialogs, which are all designed very similar (s. Fig. 4.8). You will find
a list of existing data of the specific type in the database on the left side (In
this example that are genres). To find a special Date, type in some part of the
name to filter out not suitable items (s. Fig. 4.9).
If the wanted item appears, select it with a left click and the details will be
shown on the right side. To modify the entry, click on Edit, do your changes
and click on Save. The last action stores the changes into the database and
sets the filter to the edited entry. This is done, to automatically select the last
used entry. To cancel your changes, simply click on any other item in the list
on the left, without pressing on Save. If you need another item, click on New.
This activates the empty right side and fill in the filter from the left to the
corresponding field of the new item. To add the new item to the database, click
on Save.
This dialogs are shown automatically, if you want to add a medium to the
database, which have not unique foreignkeys or the foreignkey is not found at
the database. In this case, the filter is already set to the value, which is held
by the medium. If this leads to an empty item list, please change the filter to a
more specific one, to find an existing suitable item. To choose an existing item,
select it and click Ok. If no existing item is acceptable (be aware of types, ...),
create a new one as mentioned above. To cancel the insertion into the database,
press Cancel.
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Figure 4.7: Borrow and loan media

Figure 4.8: The dialog to edit Genres
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Figure 4.9: Filter entries

4.7.1 Persons and Roles

You can add persons to a medium, which are involved in the medium, like
authors, composers, translators, orchestras and many others. The connection
between the medium and the person is called Role. The mosst common roles
are already present at the database, but you can and should also add other roles
to the database as you like. The dialog to do that, can be found at Roles under
the File menu or by clicking on New Role at the details window of the medium.

4.7.2 Manufacturers

Every medium must have a manufacturer. But to be closer to the speach of each
specific media, the manufacturer is named differently by the media types. For
example the manufacturer of a book is called Publisher, while the manufacturer
of a music device is called Label. Since all this are the same at the end and
one manufacturer can produce different types of media, all manufacturers can
be used for all types of media. This is also the reason, why the Manufacturer
entry at the File menu leads you to the used edit dialog for manufacturer.

4.7.3 Genre

Genres are also independent from the media type. The related dialog can be
reached through Genres at the File menu.

4.8 Backup and restore the Database

To create a database backup, the Database Backup dialog under Edit can be
used. At the upcoming dialog, choose the filename and location which should
be used to export to. Afterwards click on Export to start the process. The
created file contains the whole database in SQL-File format.
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Since restoring the backup is not supported by the gui, you must connect to the
mysql-server via the command line and create an empty databae (s. 2.2). The
backup can be restored with

use NAME DER LEEREN DATENBANK;
source PFAD ZUR SQL-DATEI;

afterwards.

4.9 Handling of external MimeTypes
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